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Related Documents

Ref# Title

MA-020 | Perception Desktop - Installation & User Guide

MA-022 | Perception Web - Installation & User Guide

MA-023 | Perception Workflow Designer - Installation & User Guide

Abbreviations & Definitions

Abbreviation Meaning

KPD file suffix for a Perception Database file (stored in a SQL format)

TOA file suffix for a device configuration file (stored in a CSV format)

DGA Dissolved Gas Analysis

Ccsv Comma Separated Variable — an industry-standard neutral data exchange format
SQL Structured Query Language - an industry-standard database format
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1.1

1.2

INTRODUCTION

Product Overview

Perception is a software product designed to assist power plant personnel in
the maintenance and management of oil-insulated equipment used in the
transmission and distribution of electrical power. It is used primarily for
diagnosing fault conditions as well as trending measurements taken from
transformers, circuit breakers and tap-changers.

Perception Server is designed for fleet-wide monitoring and provides time
saving scheduled downloading to automatically collect measurement data
from devices, and then store it in a central database for simultaneous user
access. The centralized location increases data integrity by creating a single
point for data backup. OPC UA architecture provides secure network
communication between client and server. Access control prevents
unauthorized access to monitoring devices, limiting unit and configuration
setting changes to designated personnel.

If a discrete, ratio or rate of change alarm is triggered on the device,
Perception Server will automatically send an email alert to notify the user of
the change. The email notification system provides details on the current
asset state, including gas levels and historical measurements. When
exceeded, caution and alarm limits are highlighted, using a predefined colour-
coding system. Email alerts can be configured at a unit level for critical
transformers. Perception also has the capability to generate more detailed e-
mails on the overall transformer state via the Expert analysis e-mail feature.

Although Perception is an expert analysis and information system, it is only an
aid and should not be regarded as a replacement for the knowledge of
someone who is an expert in the analysis of insulating oil used in electrical
equipment and the operation of oil filled power equipment.

Software Family

There are four members of the Perception family.

= Perception Desktop — A standalone software application that provides
customized access to the centrally located asset database. It provides
advanced diagnostic profiles on device data, a multi-page transformer
report containing key transformer information as well as the facility to
launch external applications. Additionally, Perception Desktop can operate
standalone or as part of a larger centralized asset management suite in
conjunction with Perception Server.

= Perception Server — The pinnacle of transformer asset management
software. Perception Server provides a fleet-wide network overview via a
wallboard display, automatic data downloading with configurable
scheduling, email notifications of device condition changes and a TOA4
data export facility. It uses a centralized data storage location based on
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SQL Server to which Perception Desktop links seamlessly via secure OPC
UA communications.

= Perception Web — A web-based solution that provides read-only access to
the centrally located asset database. This offers a convenient way to
obtain readings and consolidated data analysis across a variety of
platforms including mobile devices. This includes transformer dashboards,
wallboards and an overview to the status of the entire transformer fleet.

» Perception Workflow Designer — The workflow designer uses common
flowcharting techniques to express transformer diagnostic processes as a
model. These models are known as workflows and in turn drive the
Perception dashboard. The Designer brings easily modifiable workflow-
enabled capabilities to the Perception software suite allowing control over
the diagnostic process and customization of how data is presented on the
Perception dashboard.

1.3 What's New?

» Enhanced support for DGA 900 TapTrans Plus with models for cooling,
thermal and OLTC data, including import and export of such data.

» The Perception Server Software Activation Wizard is amended to only
permit manual activation.

» Minor enhancements and bug fixes.

Note: If upgrading to Perception Desktop/Server 2.4. X from version 1.X,
please contact GE Support before commencing as depending upon
the size and complexity of the existing database, a service visit may
be required to make the transition.
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1.4 Server Features

Perception Server offers the following:

= Automatic scheduled results downloading
» Wallboard facility gives an overview to the entire fleet

» Facilitates transformer risk evaluation, fleet ranking and transformer and
fleet dashboards

= Centralised data source allowing multiple Perception Desktop instances to
connect, gather and manipulate the same data

= E-Mail condition notifications when devices raise condition alerts,
communication issues, service or rate of change alarms

= SQL Server database storage
= Access control security with login permission level access settings
= OPC UA Server

= Ability to define a custom CSV file format for import and export, including
out-of-the-box support for Perception, TOA4 and TransConnect CSV
formats.

1.5 Architecture

The Perception Server architecture consists of one or more client PCs running
Perception Desktop and a remote server machine running the Perception
Server software as illustrated in Figure 1-1.

Perception Server utilises OPC UA Discovery Server to establish a secure
encrypted connection to a centralised repository for multiple Perception
Desktop clients. This combination allows users to add DGA devices (and other
GE transformer monitoring devices) and download the same devices and data.
Perception Server uses SQL server to host the database. SQL Server can be
hosted on the same server machine as Perception Server or on a separate
dedicated server machine.
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Figure 1-1: System architecture

System Requirements

Prior to installing Perception Server, ensure that the SQL Server bit type
matches the operating system bit type. A 64-bit Windows operating system
requires a 64-bit SQL application. Perception Server must be installed with an
appropriate database connection and then the server license must be
activated to avail of full functionality (refer to Section 2).

The minimum PC and system requirements for Perception Server are:

Operating Windows Server 2008 with .NET Framework 3.5 sp1, 4.0,
System: 4.5&4.7

Database: SQL Server or SQL Express 2008 R2

CPU: 3 GHz 32-bit (x86) or 64-bt (x64) processor

Memory: 4 GB RAM

HDD: 500 GB free

Note:

Perception Server requires FILESTREAM to be enabled on the
Microsoft SQL Server instance. This can be done during the install of
Microsoft SQL Server or retrospectively using the Microsoft SQL
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Server Configuration Manager. Ensure that the correct bit version of
Microsoft SQL Server is installed to match the bit version of the
operating system, e.g. 64-bit Microsoft Windows 10 must have 64-bit
Microsoft SQL Server installed. If there is a mismatch in bit versions
FILESTREAM will not work. Visit
https://msdn.microsoft.com/en-us/library/cc645923.aspx for more
details.

Note: Windows Server 2012 does not enable Microsoft .NET 3.5 features by
default. However, all Perception installers require .NET 3.5.

Note: Itis possible to exceed the SQL Express database size limit of 10 GB
so upgrading to SQL Server is recommended if there are many
monitoring devices and/or large data imports expected.

MA-021 - Perception Server 2.4.7 — Installation & User Guide - Rev 10.3 22-Oct-24 Page 9 of 53


https://msdn.microsoft.com/en-us/library/cc645923.aspx

1.7 Software Licensing

Perception Desktop uses a tier-licensing model when used with Perception
Server. This provides greater flexibility to add devices and manage license
expiry. There are six tiers in the model, as listed in Table 1-1, with each tier
supporting an increasing number of devices according to a range of
accumulated device weightings.

Table 1-1: Tier scores
Tier Accumulated
weightings
0-50
51-100
101-150
151-250
251-500
501+

O lW|IN| =

The weighting scores for each type of device are listed in Table 1-2.

Table 1-2: Device scores
Device Weighting Score

Offline

201Ti

Hydran M2 / M2-X

8 series relays

MO150

MiniTrans

CB Watch3

Transfix

DGA 500

DGA 900

BMT 300

BMT 430

DualTrans

TapTrans / DGA 900 TapTrans
MultiTrans / DGA 900 MultiTrans
Transfix Plus

DGA 900 Plus

TMS

MS 3000

—_

NIN|[O|Oo|o|aojaojanfajfuajlalu|dh|Dh]IDRIOlW|IN

You can add any number of devices and assets within the limits set by the
Perception fleet license tier. To add further devices or assets requires a
license upgrade — contact Customer Support.

Note: Customers on an existing annual fleet licensing agreement can add
assets and devices beyond the limits set by the new license tier.
However, once the annual fleet license agreement expires, the license
tier is recalculated and may require an upgrade to service all devices.

Note: When connected to Perception Server, the Fleet Summary window
becomes available in Perception Desktop and provides details on the
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Perception license tier including expiry date and a summary of the
devices and assets that have been added to the database.

1.7.1 License Expiry

A License Expiry message appears in Perception Desktop 90 days before the
Perception fleet license is due to expire as shown in Figure 1-2. Reminder
messages are automatically scheduled to reappear at 60 days, 30 days, 15
days and 5 days, or on each first launch of the application within the set days
of the expiration period.

Note: This reminder applies to annual license agreements only.

& Perception Desktop

=RRCIN X

Perception Fleet Version 2.4.7

Your Perception Fleet License will expire in 35 days,
please contact a GE sales representative to extend your license
period.

If you do not choose to extend your license pericd you can still use
Percepticn Fleet however the following key features will no longer
be available.

-Transformer Risk Evaluations
-Fleet Ranking

-Transformer and Fleet Dashboard
-Wallbcard Flest Visualisation
-Perception Wek

-Expert Email Motifications

To reactivate you license please contact your local sales
representative or email sales.digitalenergyMDi@ ge.com.

Please quote Perception Fleet License Tien &

Figure 1-2: License expiry notification

A yellow warning icon also appears in the lower right corner of the application
window with a tooltip when you rest the mouse pointer over it as shown in

Figure 1-3.

4

Your Perception Fleet License is about to expire
Click for detailed information.

Figure 1-3: License warning indicator

Perception Server restricts functionality after license expiration. The following
features are disabled:

= Transformer Risk Evaluations

= Fleet Ranking

= Transformer and Fleet Dashboard
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= Wallboard Fleet Visualisation
= Perception Web
= Expert Email Notifications

1.7.2 Fleet Summary

Perception provides a useful summary dialog with license tier details and all
assets and devices that comprise the Perception Fleet. Select Help > Fleet
Summary as shown in Figure 1-4.

ﬂ Perception Desktop

About...
Fleet Summary...

Asset Hierarchy Transformer Technical Services...

Figure 1-4: Help menu

The Fleet Summary dialog displays as shown in Figure 1-5.

Perception Fleet Summary
Version

Copyright & GE Digital Energy 2019

Perception Fleet License Tier: 6 Predicted Perception Fleet License Tier for the following year 6+

Perception Fleet License will expire on 21 April 2020,

Perception Fleet Summary Devices added since last activation

Transfix 1.6: 2 Transfix 1.6: 1 =
MultiTrans: 1 DGAS00: 1

DGA 500: 2 Transformers with imported data: 1

BMT 300/330: 3
Transfermers with imported data: 1
CBWatch: 1

To renew your license, please contact your local sales representative, or email salesdigitalenergyMD @ge.com and quote your Perception
Fleet License Tier,

License Key:

Figure 1-5: Fleet Summary dialog

1.8 Customer Support

E-mail: ga.support@ge.com
North America: 1-877-605-5777
Worldwide: +44 1785-250-070
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2 INSTALLATION

2.1 Overview

The Perception Server Installer installs Perception Server and the Perception
Server Configuration Tool. If the UA Local Discovery Server service is also
installed, it is bound to the Perception Server, so restarting the UA Local
Discovery Server also restarts the Perception Server. The Perception Server
and Desktop are supplied on separate installation CDs.

2.2 Run the Perception Server installer

To install Perception Server, insert the Perception Server CD into the CD drive
and double click the Perception.Server.Setup.exe file in the root directory of
the CD. The Setup Wizard opens as shown in Figure 2-1. Click Next to
proceed to the License Agreement.

Welcome to the Perception Server Setup Wizard

The ingtaller will guide vou through the steps required to ingtall Perception Server on pour computer.

WARMIMG: This computer program iz protected by copyright law and international treaties.
IInauthorized duplication or distibution of thiz program, or any portion of it, may rezult in zevere civil
ar criminal penalties, and will be progzecuted to the maximum extent pogsible under the law.

Cancel ¢ Back

Figure 2-1: Welcome to the Perception Server Setup Wizard
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If the License Agreement is acceptable, select | accept the terms in the
License Agreement and click Next as shown in Figure 2-2.

License Agreement

FORM ES105 (REV 3): SOFTWARE LICENSE
NOTICE - READ THIS CAREFULLY: THIS IS A LEGAL AND BINDING
AGREEMENT BETWEEN YOU AND LICENSOR. BY INSTALLING THE
SOFTWARE, YOU AGREE TO ALL THE TERMS AND CONDITIONS
OF THIS SOFTWARE LICENSE (“LICENSE"). IF YOU DO NOT
AGREE TO THESE TERMS, DO NOT INSTALL THE SOFTWARE.
YOU MAY RETURN THE SOFTWARE, ALL MANUALS,
DOCUMENTATION AND PROOF OF PAYMENT TO LICENSOR
WITHIN 30 DAYS OF PURCHASE FOR A FULL REFUND. o

(®) | accept the termz in the License Agreement

()| do not accept the terms in the License Agreement

Figure 2-2: License Agreement

Browse to select the installation folder or accept the default folder and click
Next to continue as shown in Figure 2-3.

Note: If the PC is shared with other users, you can choose to install

Perception Server for use under the current login account only, or for
all user accounts on the PC.
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Select Installation Folder

The installer will install Perception Server to the following folder.

To ingtall in this folder, click "Mext". Tao install to a different falder, enter it below or click "'Browse".

Enlder:
C:\Program Files [#86)%GE Digital EnergysPerception 2.4.74 Browse...

Dzl Cozt...

Install Perception Server for yourself, or for anyone who uses this computer:

(®) Everyone
() Just me

Cancel < Back

Figure 2-3: Select Installation Folder

Click Next to start the installation, Back to backtrack and change some of the
selections, or Cancel to quit the process entirely, as shown in Figure 2-4.

Confirm Installation

The inztaller iz ready to install Perception Server an pour computer.

Click "Mest" to gtart the installation.

Cancel < Back

Figure 2-4: Confirm Installation
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Click Next and a progress bar indicates the progress as shown in Figure 2-5.
The installation may take some minutes.

Installing Perception Server

Perception Server iz being installed.

Please wai...

Cancel < Back Meut

Figure 2-5: Installing Perception Server

The Setup Wizard completes the installation and presents the following
message as shown in Figure 2-6. Click Finish to exit.
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Installation Complete

Perception Server haz been succezsfully installed.

Click "Finish'' to exit.

Recommended Software:

Select the zoftware and click Install Mowe. Toinstall later, launch installer from C:\Program Files
[#36])GE Digital EnergyhPerception 2.4, 743rdParty directamn.

[] TransCom [Provides support for Transfix 1.5) [rgkall Mo

Fleaze uze Windows Update to check for any critical updates to the MET Framework:.

Cancel < Back

Figure 2-6: Installation Complete

To install the TransCom software for TRANSFIX 1.0/1.5 device support, select
the TransCom option and click Install Now.

2.3 Create the Perception Server database

Perception Server uses SQL server to host the Perception Server database.

Note: SQL Server can be hosted on the same server as the Perception
Server or on a separate dedicated server machine.

To create the Perception Server database:
= Open SQL Server Management Studio.

= Log in using an Administrator account as shown in Figure 2-7.
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2.4

= comectosener NN
» Microsoft*
2 SQLServer2008r2

Server type: Database Engine v]
Server name: localhost\SQLEXPRESS
Authentication: [Wundows Authentication

Figure 2-7: SQL Server login

* Run the CreateSQLServer2005Schema.sql file in the Perception Server
installation folder. Typically found in C:\Program Files\GE
Energy\Perception\SQL Schema.

= To apply the changes made by the schema, including manual database

changes to the Perception Server, restart the Perception Server service.
By default, a database called ‘Kelman’ is created in the SQL database list —
this database is used by Perception Server to host the data.

A specified SQL user account must be configured with ‘db_owner’ rights to the
specified database. These account details are added using the Perception
Server Configuration Tool to establish a connection between Perception
Server and SQL. See Section 2.5 Connect Perception Server to the database.

Note: SQL Server 2012 and 2014 do not give ‘NT AUTHORITY\SYSTEM’
‘sysadmin’ permissions by default — users should assign this
permission manually in SQL Management Studio - Logins.

Enable MS-DTC Service

To communicate with the SQL Server databases, the MS-DTC service must be
enabled on the Perception Server.

Select Start > Run, type services.msc and click OK.

In the Services window, select the Distributed Transaction Coordinator
service and click the Start Service button as shown in Figure 2-8.
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Note: To ensure that the service always runs if the PC restarts, right click on
the service and select Properties. Set the Startup type to Automatic
and click OK.

C—m Services (Local)
Select an item to view its description, | Name ’ Description Status Startup Type Log On As .
~: DCOM Server Process Launcher The DCOMLAUNCH servi... Started Automatic Local Syste...

esktop Window Manager Session Manager Provides Desktop Windo... Started  Automatic Local Syste...

HCP Client Registers and updatesIP ...  Started Automatic Local Service E
iagnaostic Policy Service The Diagnostic Policy Ser.. Started Automatic Local Service

Diagnostic Service Host The Diagnostic Service H...  Started Manual Local Service

iagnostic System Host The Diagnostic System H... Manual Local Syste...

isk Defragmenter Provides Disk Defragmen... Manual Local Syste...

Distributed Link Tracking Client Maintains links between ... Started Automatic Local Syste...

istributed Transaction Coordinater Ceordinates transactions ... Manual Netwoerk ...

NS Client The DNS Client service (d.. Started Automatic Netwoerk S...

ncrypting File System (EFS) Provides the core file enc... Manual Local Syste...

ensible Authentication Protocol The Extensible Authentic... Manual Local Syste..

Fax Enables you to send and ... Manual Network ...

unction Discovery Provider Host The FDPHOST service ho...  Started Manual Local Service

(. Function Discovery Resource Publication Publishes this computer ... Manual Local Service

Bxtended A Standard /

Figure 2-8: Services - Select the Distributed Transaction Coordinator Service
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2.5 Connect Perception Server to the database

Open the Perception Server Configuration Tool and select the Database tab
as shown in Figure 2-9. Note: All other tabs are disabled if the database is yet
to be configured.

i Perception Server Configuration Tool — O -

File Help ’
I@I GE VERNOWA

Alarm | Modem| Database |User | Activation | Export | Map

Please restart the server after changing the database configuraticn.

User &ccess

Integrated Security
User Id

Password

Server Location
Vendor | S0LServer

Db Instance |G19322T3EVSCLEXPRESS
Database |Kelman

Port

Behaviour settings
Disable device data download [

Save Reset

Figure 2-9: Perception Server Configuration Tool — Database tab

The recommendation is to use ‘Integrated Security’ (Windows Authentication)
to connect to the Perception Database, since Perception Server uses
‘FILESTREAM’ which does not support SQL Authentication.

Currently Integrated Security doesn’t support Active Directory so this requires
that you manually create the same Windows user on the SQL Server machine
to match the credentials of the user on the Perception Server machine.
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The Disable device data download checkbox disables data download from
the device. This prevents measurement data from being downloaded each
time the unit connects with Perception, but still allows Perception to poll for
the service information from the device and receive operational status
information. This is useful in organisations where other applications, such as
data historians are used to store measurements, as it prevents the storage of
duplicate measurement data.

Note: If Perception Server is installed on a different machine to the
database, ensure that the account used to run Perception Server has
access rights for FILESTREAM access on the Microsoft SQL Server
instance. (Perception Server logs this fact in the Server.log file).

2.5.1 User Access

Select the security connection method defined by your System Administrator.
An ‘Integrated Security’ connection uses the profile of the currently logged-in
user.

If your MS SQL setup requires login credentials for access control, uncheck
‘Integrated Security’ and enter the user ID and password of the SQL user who
has permission to access the Kelman database. The MS SQL login used must
have the “db_owner” membership role for the Kelman database.

2.5.2 Server Location

Enter your SQL Server instance information into the Db Instance box.
Typically, this is the computer name of the SQL Server host and the SQL
Server instance name (i.e. SQLServerHost\SQLExpress). Finally, type
Kelman into the Database box and click Save.
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2.6

Activate the Perception Server

Before the Perception Server Service can be started, the Perception Server
must be activated with a license key. Open the Perception Server
Configuration Tool and select the Activation tab as shown in Figure 2-10.

- a X

i Perception Server Configuration Tool

File Help ’
I@I GE VERNOWA

Alarm | Modem | Database | User | Activation | Export | Map

Please restart the service after activating or reactivating.

Activation
Please click the button below to activate Perception Server,

Reactivation

Please reactivate your license to apply your device limit upgrade.

Reactrvate

Figure 2-10: Activate the Perception Server
Click Activate to open the license key activation wizard and follow the
onscreen instructions (see Section 2.8).
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2.7 Reactivate the Perception Server

If the Perception Server needs to be reactivated (i.e. if the device limit has
been changed), open the Perception Server Configuration Tool and select the
Activation tab as shown in Figure 2-11.

% Perception Server Configuration Tool — O x

File Help ’
I@I GE VERNOWVA

Alarm | Modem | Database | User | Activation | Export | Map
Please restart the service after activating or reactivating,

Activation

Please click the button below to activate Perception Server,

Activate

Reactivation

Please reactivate your license to apply your device limit upgrade,

Reactrvate

Figure 2-11: Reactivate the Perception Server

Click Reactivate and follow the onscreen instructions.
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# License Key Reactivation

License Key Reactivation.

Your Activation Key has been validated

Click Next
Cancel | | Back Next |  Finish
Figure 2-12: License Key Reactivation
Click Next.
i License Key Reactivation. x
License Key Reactivation Completed.
Your license has been reactivated.
To close this window click Finish
| Cancel | | Back Next | | Finish

Figure 2-13: License Key Reactivation — Complete

Click Finish.
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2.8 Perception Server Software Activation Wizard

The Activation Wizard walks through the license activation process as shown
in Figure 2-14. Click Next to proceed.

i Activation Wizard %

Welcome to the Activation Wizard

This wizard will walk you through license activation process.

To start activation process, click Next.

Back Next Finish

Figure 2-14: Welcome to the activation wizard

Enter the license key provided with the Perception Server software and click
Next as shown in Figure 2-15.

i Activation Wizard x

License Key activation

License Key:

Type in recerved License Key and click Next.

| Cancel | [ Back | Next

Figure 2-15: License key activation
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To activate the Perception License Key, contact GE Vernova Support and
supply the identifying information as shown in Figure 2-16. GE Vernova
Support will provide the activation key to be entered below.

i Activation Wizard *

License Key activation

Installation Key:

Copy Installation Key

To activate the Perception License Key please contact GE Vernova support and provide the following infarmation:
Installation Key, Company Name, Country, Area, First Name, Last Name, Email Address and Pesition

Email: perception.activation@ge.com

North America toll-free: 1-800-361-3652

‘Worldwide: 1-514-420-T460

GE Vernova support will provide the activation key to be entered below.

Plaase do not close the eense wizard until the Activation Key received from GE Vernova support.

Activation Key:

After providing valid Activation Key click Next.

[ concet || Back | Nea |

Figure 2-16: Manual activation
Note: Automatic activation via the web site is no longer supported.

The software validates the license key. If successful, a message displays as
shown in Figure 2-17. Click Next to continue.

A% Activation Wizard %

License Key activation

Your Activation Key has been validated

Click Next

‘ Cancel || Back Next Finish

Figure 2-17: Manual validation of the key successful
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Confirmation of successful license activation is shown in Figure 2-18. Click
Finish to exit the Activation Wizard. To add a user, see Section 3.3.1.

i Activation Wizard X

License Key activation completed

Your license has been activated.

Te close this window click Finish

Figure 2-18: Manual validation complete

2.9 Establish Client Connections

There are several prerequisite steps to perform before client\server
communications are operative:

= The client PC must have Perception Desktop installed.
= A user must be created in the Perception Server Configuration Tool.
» The user must attempt to open the connection with the Perception Server.

= Both the client user and the server administrator then must override their
respective trust certificates before the client-server link can work.

= Every time a new client user is added, both the user and the server
administrator must act together to override their trust certificates.

2.9.1 Trust the Client Certificate

The first time that a Perception Desktop client attempts to connect with the
server, the connection is rejected as shown in Figure 2-19. This is because the
client does not trust the server. To trust the server certificate, the certificate
must be moved from the rejected certificate folder and added to the trusted
certificate folder.
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2.10

»
Connection Error @

::I Server Certificate not Trusted.

A

Figure 2-19: Server certificate not trusted

Subsequently another connection error occurs as shown in Figure 2-20. This
time because the server does not trust the client. To trust the client
certificate, the certificate must be moved from the rejected certificate store
and added to the trusted certificate store.

e <
Connection Error @

| Client Certificate not Trusted.

b

Figure 2-20: Client certificate not trusted

This will occur with every first connection attempt of a new user and so needs
both the client user and server administrator to be logged in so that both can
move the respective certificates to the trusted certificate store. To do this,
follow these steps:

In Windows 7/Server 2008, open Windows Explorer and navigate to the

following location:
C:\ProgramData\GE Energy\Perception\RejectedCertificates

Look for a certificate with this format: Perception.Desktop.<computer
name> [key], where <computer name> is the computer name of the client and
[key] is the public certificate key.

Move the certificate from the rejected certificates folder to the trusted
certificates folder at this location in Windows 7/Server 2008:

C:\ProgramData\GE Energy\Perception\TrustedCertificates\certs

Firewall Settings

In order that the client and server successfully communicate, Perception
Desktop must be allowed to communicate through the firewall. A firewall
program is usually accessed via the Windows Control Panel. In the advanced
settings for Perception Server, ensure that ports 4840, 4841 & 62541 are
open for inbound connection on the Perception Server machine.

If the UA Discovery Server application is installed, it should be added as a
program that can send and receive through the firewall.
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2.11 Perception Database Upgrade Tool

If migrating from a previous version of Perception or if you wish to import data
from a legacy database, you must use the Perception Database Upgrade Tool
to convert the database to a compatible format. The Perception Database

Upgrade Tool can be used in several migration scenarios, such as converting:

= an older local (KPD) database to a Perception 2.0 local (KPD) database
= an older local (KPD) database to a Perception 2.0 SQL Server database

= an older Perception SQL Server database to a Perception 2.0 SQL Server
database

The Perception Database Upgrade Tool can be found at the following location:

C:\Program Files (x86)\GE Digital Energy\Perception 2.4.5

Double click the Perception.Database.Upgrade.Tool.exe file to open the tool
as shown in Figure 2-21.
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File Help .
@l GE VERNOVA

Specify the upgrade to perfarm

From Database ) SQL Server @ KPD

To Database ) SQL Server @ KPD

Path to KPD File [I]

User Access
Integrated Security
User Id

Password

Database Server Location
Vendor SQLServer
DB Instance lacalhost\SQLEXPRESS

Database Kelman

Progress

Status

Figure 2-21: Perception Database Upgrade Tool
Use the tool to specify the source and destination database formats.

Note: Depending on the type of upgrade, a path or database connection
details may also be required.

If moving from a local KPD database to a SQL Server database, use the tool to
add appropriate user access.

Finally, in the Database Server Location section, ensure that the tool is
pointing to the newly updated database.

Click Upgrade to start the upgrade process.

Note: Customers should be aware that Perception does not support the
‘merging’ of databases.

Note: If any issues occur during the migration of Server data, contact
Customer Support.
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3 CONFIGURATION

3.1 Functionality Overview

The Perception Server Configuration Tool allows complete configuration of
the Perception Server. Once installed, the user interface presents seven tabs
as shown in Figure 3-1.

% Perception Server Configuration Tool — O =

File Help :
I@I GE VERNOWVA

Alarm | Modem | Database | User | Activation | Export | Map
Please restart the server after changing the alarm configuration

Login Information

Requires Authentication [ ]
User Id

Password

Server Information

Outgoing mail server (SMTP)
Port

Enable SSLATLS (explicit) [ ]
E-mail Address

Expert E-mail [ ]

Expert E-mail history record count 20

Maximum communication
failure count

Wallboard pulsing
[ Enable pulse for all nodes

Save Reset Test

Figure 3-1: Perception Server Configuration Tool

The seven tabs provide access to the different configuration themes of
Perception Server as outlined below:

» Alarm: See Section 3.4 Configure Alarm Emails.

» Modem: See Section 3.5 Configure Modems.
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3.2

3.3

= Database: See Section 2.5 Connect Perception Server to the database
(performed during the initial installation).

» User: See Section 3.3 Configure Users.

= Activation: See Section 2.6 Activate the Perception Server.
= TOA Export: See Section3.6 Export Download Data to TOA.
» Map: See Section 3.7 Define Custom CSV Mappings.

Menu Options

The menu bar consists of two menus — File and Help.

» File > Exit: Closes the Perception Server Configuration Tool.

» Help > About: Displays an information dialog containing the Release notes,
License agreement and Component version numbers.

Configure Users

By default, the Perception Server allows anonymous connections from
Perception Desktop. This is less secure as access is not restricted to requiring
valid login credentials. It is recommended that all users are configured on the
Perception Server to provide an audit trail of all user actions. See Appendix A
for details on how to remove anonymous users. To configure users on the
Perception Server, open the Perception Server Configuration Tool and select
the User tab as shown in Figure 3-2.

As a security precaution, the user session in Perception Desktop can be
controlled from Perception Server to automatically close in the case of a
period of inactivity. The User Session Settings define the Inactivity timeout in
minutes, where 5 minutes is the default. To turn off the inactivity timeout
period, change this value to O to ensure that the session stays open.
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,_ Perception Server Configuration Tool — | -
e Help |@. GE VERNOVA

Alarm | Modem | Database| User |Activation | Export | Map

Please restart the server after changing active directory configuration

User Session Settings

Inactivity timeout (minutes) (|5

Active Directory
Enable L]

Architect Group
Supervisor Group
Observer Group

Irnport Permissions Group

Perception users

Username Role Import Permission
Ed Architect v
Jim Cbserver
Robert Supervisor
Add Edit Delete

Figure 3-2: Configure users

In the example above, Ed is of ‘Architect’ status (full read-write with workflow
permissions), Jim is of ‘Observer’ status (read-only permissions) and Robert is
of ‘Supervisor’ status (full read-write permissions).

By default, users are authenticated internally against the list of Perception
Users as shown, for example, in Figure 3-2, but alternatively can be
authenticated using the operating system'’s Active Directory. To enable Active
Directory, select the Active Directory checkbox and type the predefined
network group names in the respective text fields to map the Active Directory
users to Perception roles. For example, if the user is in the network Architect
User Group, then it will resolve as a user of the ‘Architect’ role in Perception.

If Active Directory is enabled, Perception will first attempt to authentic users
using Active Directory and if not found, then attempts authentication against
the internal list of Perception Users.
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Note: The Import permission is an additional right that can be assigned to
any role. Inadvertently importing the wrong data could overwrite valid
data, so this right should be assigned with caution.

3.3.1 Add a user

To add a new user, click the Add button. The Add User dialog displays as
shown in Figure 3-3.

4 Add User (=) |

Username

Pazzword

Confirm Password

Role [ Supervisor x ]

Cancel

Import Permission O

L.

Figure 3-3: Add user dialog

Specify a username and password. Assign a role according to the required
permissions outlined in Table 3-1. If the user requires Import Permission,
select the Import Permission checkbox. Click OK to add the new configured

user.
Table 3-1: Role permissions
Role Permission
Supervisor Full read / write access
Observer Read Access only
Architect Full read / write access with workflow

The new user is added to the list of users as shown in Figure 3-4.
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& Perception Server Configuration Tool — O >
File Help g
|@I GE VERNOWA
Alarm | Modem | Database | User | Activation | Export | Map
Please restart the server after changing active directory configuration
User Session Settings
Inactivity timeout (minutes) |5
Active Directory
Enable L]
Architect Group
Supervisor Group
Observer Group
Irnport Permissions Group
Perception users
Username Role Import Permission
AN Other Supervisor
Ed Architect v
Jirn Observer
Robert Supervisor
Add Edit Delete

Figure 3-4: List of users

3.3.2 Edit a user

To edit a user, open the Perception Server Configuration Tool and select the
User tab as shown in Figure 3-4. Select a user and click the Edit button. The

Edit User dialogue is displayed as shown in Figure 3-5.
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‘- M
7 Edit User ==

Username AN Other

Passward R

Confirm Password  FHEE+*

Role [Supenrisar "l

Impart Permission O

o (o]

b

Figure 3-5: Edit user details

It is possible to change all details except the Username. Click OK to confirm
the change.

3.3.3 Delete a user

To delete a user, open the Perception Server Configuration Tool and select
the User tab as shown in Figure 3-4. Select a user and click the Delete
button.

Confirm Delete L_J

(o:l Are you sure you want to delete AN Other 7

Yes | Ne |

Figure 3-6: Delete a user

A confirmation message appears. Click Yes to delete the user.
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3.4 Configure Alarm Emails

Emails can be issued to alert users of device condition or communication
issues. To configure the server to issue emails, open the Perception Server
Configuration Tool and select the Alarm tab as shown in Figure 3-7.

Note: To receive such emails, Perception Desktop must be configured with
an email address in the Notification E-mail Address box via the
device’s Properties tab. See Section 3.8.4 Device Properties in the
Perception Desktop Installation & User Guide.

i Perception Server Configuration Tool — O >

File Help :
I@‘J GE VERNOWVA

Modem | Database | User | Activation | Export | Map
Please restart the server after changing the alarm configuration

Login Information

Requires Authentication [ ]
User Id

Password

Server Information

Qutgoing mail server (SMTP)
Port

Enable SSLATLS (explicit) [ ]
E-mail Address

Expert E-mail [ ]

Expert E-mail history record count | 2

Maximum communication
failure count

Wallboard pulsing
[ Enable pulse for all nodes

Save Reset Test

Figure 3-7: Alarm email configuration
The following details need to be completed:
Login Information: Enter the authentication details to allow access to the SMTP

server. Note: Consult with your IT Administrator to see if authentication is
required.
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3.4.1

3.5

Server Information:
In the Outgoing mail server (SMTP) box, enter the SMTP server address.
In the Port box, enter the email port — typically 25.

In the Enable SSL\TLS (explicit) checkbox, select the checkbox to enable this
feature. This provides support for an encryption protocol to secure SMTP
connections over ports 25/587.

In the E-mail Address box, enter the email address of the sender of the emails
E.g. ‘noreply@yourcompany.com’. Note: The email address does not have to
exist.

In the Expert E-mail checkbox, select the checkbox to enable this feature.
See Section 3.4.1 below.

In the Maximum communication failure count box, specify the number of
failures required before an email is sent. This is designed to limit the number
of emails recipients receive about a communication issue.

Wallboard pulsing:

In the Enable pulse for all nodes checkbox, select the checkbox to enable the
dynamic animations such as pulsing or rippling on all assets on the Perception
Desktop wallboard (when an alarm is triggered or a risk index changes). The
default is Off.

Expert analysis emails

A further email can be issued to nominated persons containing more detailed
information on the alarm.

To enable this feature, select the Expert E-mail checkbox in the Perception
Server Configuration Tool.

In the Expert E-mail history record count, specify the number of records to
be included as a CSV attachment in the email. The default is 20.

Note: To receive such emails, Perception Desktop must be configured with
an email address in the Expert E-mail Address box via the device’s
Properties tab. See the Perception Desktop Installation & User Guide
for ‘Setting up Asset Properties > Device Properties > Email’.

Configure Modems
To configure the modems used by Perception Server, open the Perception
Server Configuration Tool and select the Modem tab as shown in Figure 3-8.

All available modems to the Perception server are listed. Select the checkbox
next to each modem you want the Perception Server to use.
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When Perception Server attempts a data download, the Server will use the
first available modem in the list. If that modem is busy, the server will try the
next selected modem on the list until an available modem is found.

Note: Ensure that selected modems are exclusive to Perception Server and
not used by any other applications running on the Perception Server

host.
1% Perception Server Configuration Tool — | *
File Help ’
I@I GE VERNOWA

Alarm | Modem | Database | User | Activation | Export | Map
Please restart the server after changing the modem configuration.

| i Standard 56000 bps Modem

Save Feset

Figure 3-8: Modem configuration

3.6 Export Download Data to TOA

If interrogation and analysis is required using other tools, the Server can be
configured to export all downloaded data to the universal TOA format.
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Select the Export tab and select the Export download data to TOA files
checkbox as shown in Figure 3-9.

» Perception Server Configuration Tool — O 4

File Help ’
I@I GE VERNOVA

Alarm | Modem | Database | User | Activation | Export | Map
Please restart the server after changing the export configuration,

Configure Exports
Export download data to TOA files [

Export Risk Rank data [

Save Reset

Figure 3-9: TOA Export

The files are stored at the following location:
C:\ProgramData\GE Energy\Perception\Export\TOA
The files are named as follows:

<device serial number> YYYYMMDD Time.TOA

Where YYMMDD is the date in reverse order so that it is listed in the correct
chronological order in Windows Explorer.
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3.7 Define Custom CSV Mappings

The Map page allows you to define custom CSV mappings for imports and
exports. Click the Import tab to specify the source and destination field names

to ensure correlation of the imported data.

File Help

Import | Export

j& Perception Server Configuration Tool

Alarm | Modem | Database | User | Activation | Export | Map

Please restart the server after changing import map configuration.

- O X

I@I GE VERNQOWVA

Import Map Add Delete
Source Destination

equipnum equipnum

serialnum SerialMurnber

appriype appriype

tank tank

sampledate sampledate

assettype assettype

pgasrrorcodes pgaemorcodes

CilSourcef|H2

QilSourceA|H2

CilSourceA|C2H2

QilSocurceA|C2H2

CilSourceA|H20

QilScurceA|H20

CilSourceA|CO

QilSourceA|CO

CilSourceA|C2H4

CilSourced]C2H4

CilSourceA|C2HE

QilSocurceA|C2HE

CilSourceA|CH4

QilSourceA|CH4

CilSourceA|CO2

CQilSourceAlCO2

= Reset

Figure 3-10: Import Mappings

Note: The import map now includes alarms and engineering units.

Click the Export tab to customise the export in a similar way.
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File Help

Import | Export

& Perception Server Configuration Tool

Alarm | Modem | Database | User | Activation

Export | Map

Please restart the server after changing export map configuration.

Select date and time format for export: | yyyy-MM-ddTHH:mmZ ~

I@I GE VERNQOWVA

O X

Export Map Add Delete
Reorder rows; ‘I} {L
Source Destination
Save Reset

Figure 3-11: Export Mappings

If the export table is empty, click Add to add the default fields serialnum,
sampledate and asssettype to the table as shown in Figure 3-12.
Additionally, you can select a date and time format and reorder the rows

accordingly.
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File Help

4 Perception Server Configuration Tool

| Alarm | Modem | Database | User | Activation | Export| Map |

@I GE VERNQOWVA

O X

Please restart the server after changing export map configuration.

Select date and time format for export: | yyy-MM-ddTHH:mmZ ~

Export Map Add Delete
Recrder rows:

Source Destination
serialnum serialnum

sampledate sampledate
assettype assettype

Save

Reset

Figure 3-12: Custom CSV mappings

MA-021 - Perception Server 2.4.7 — Installation & User Guide - Rev 10.3

22-Oct-24

Page 43 of 53



Appendix A Removing anonymous user permissions

Anonymous user access is enabled by default. This means users do not have to supply
a username or password to login to the server, but are limited to Observer (read-only)
status. However, for security reasons it may be prudent to remove anonymous user
access.

The user token permissions are in the “perception.server.config.xm” file which
can be found in the following folder on Windows 7 or Server 2008:

C:\ProgramData\GE Energy\Perception

The anonymous user token policy code is as below:

-<UserTokenPolicies
xmlns:d2pl="http://opcfoundation.org/UA/2008/02/Types.xsd">
-<d2pl:UserTokenPolicy>
<d2pl:PolicyId xmlns:i="http://www.w3.0rg/2001/XMLSchema-
instance" i:nil="true"/>
<d2pl:TokenType>Anonymous 0</d2pl:TokenType>
<d2pl:IssuedTokenType
xmlns:i="http://www.w3.0rg/2001/XMLSchema-instance"
i:nil="true"/>
<d2pl:IssuerEndpointUrl
xmlns:i="http://www.w3.0rg/2001/XMLSchema-instance"
inil="true"/>
<d2pl:SecurityPolicyUri
xmlns:i="http://www.w3.0rg/2001/XMLSchema-instance"
inil="true"/>
</d2pl:UserTokenPolicy>

The d2p1 section is repeated for ‘Observer and ‘Supervisor tokens. You can delete all
between, and including the lines d2p1.... to /d2pl... or comment it out by
changing <d2p1l:UserTokenPolicy> to <!--d2pl:UserTokenPolicy> and
</d2pl:UserTokenPolicy>t0o </d2pl:UserTokenPolicy>-->
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Appendix B Communicating with Perception Server via OPC
UA

Perception Server utilizes OPC UA to establish secure client\server communications to
and from Perception Desktop.

OPC UA also provides a standardised secure communication protocol that third party
applications can use to communicate directly with the Perception Server. This allows
other products to read, write and poll information from Perception Server.

Refer to the online OPC foundation documentation for technical information on
communicating using OPC UA. Visit https://opcfoundation.org/.
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Appendix C

Troubleshooting

C.1 Tabs not enabled on the Perception Server Configuration

Tool

For the Perception Server and Perception Server Configuration Tool to run in
the Windows 7 environment with multiple users, the SQL Server/ SQL Express
login must be given “sysadmin” rights. The following steps outline the process
to make the necessary changes in the database security settings:

1. Launch Microsoft SQL Server Management Studio application.

2. Expand the Security node as shown in Figure C-1.

3. To create the required login, right click on the Logins node and select New

Login.

732 Microsoft SQL Server Management Studio

File Edit View Tools Window Community Help
S NewQuery | [}y [[3 | 5 =8
& @ HowDol + Q Search [ Index {3 Contents []Help Favorites
Object Explorer ~ & %||_~Object Explorer Details
Connect ~ 9§ =3 E2 @& T [E 5| search

[ GE-TESTPC-I\SQLEXPRESS (SQL Server 10.50. | GETESTPC-1\SQLEXPRESS (SQL Server 10.50.1600 - GE-TestPC-1huser)\Security
atabases

) Ask a Question ) L _

Name Policy Health State
(3 Logins
3 Server Roles
(3 Credentials

3 security 3 Items

!

Ready

Figure C-1: SQL Server Management Studio Express Tool

The Login - New dialog appears as shown in Figure C-2. Select the General

node and then click the Search button.
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[ M
5 Login- New e (= foi]
Selectapage - y

Seript |74 Hel
Bl Gerersl S5 serat = [y Help
4 Server Roles
47 User Mapping e
# Securbles i !
4 Status @ Windows authentication
() SQL Server authentication
() Mapped to cerficate
(&) Mapped o asymmetric key
FEmmecaon [C] Map to Credential
Server Mapped Credentials Credential Provider
GE-TESTPC-1\SQLEXPRESS
Connection
GE TestPC-Thuser
43 View connedtion properties
Progress
Ready Defauit database: [master -
Defaut language [ cdefauk> 3
Figure C-2: Login > New Dialog

The ‘Select User or Group’ dialog appears as shown in Figure C-3. Click the
Advanced button to expand the dialog as shown in Figure C-3.

Select User or Group - - W - M
Select this object type:
User or Builtin securty principal CObject Types...
From this location:

GE-TESTPCA1

Locations...

Enter the object name to select (examples):

Check Names

-
=

Cancel

Figure C-3: Select User or Group dialog

Click the Find Now button as shown in Figure C-4 to list all the Users and
User Groups in the lower section of the window.
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-
Select User or Group @lﬂ
Select this object type:

User or Buitt-n security principal Object Types..

From this location:

GE-TESTPC-1
Marme: Starts with Columns...
Description: | Starts with

Disabled accourts Stop

MNon expiring password

Days zince last logon:

¥

|
Search results: oK Cancel

| Mame (RDN) In Folder

Figure C-4: Select User or Group dialog — expanded
Select Authenticated Users as shown in Figure C-5 and click OK to continue.

: Search results: [ OK(\ ]’ Can@ ]

| Mame (RDN) In Folder

|| @5 Admiristrator GE-TESTPC-1

3 ANONYMOUS LOGON

&2 BATCH

82 CONSOLE LOGON

M2 CREATOR GROUP

2 CREATOR OWNER 1
&2 plALUP

% Everyone

24 Guest GE-TESTPC-1
[ .

| »

m

Figure C-5: List of users and groups

In the ‘Login — New’ dialog, select the Server > Roles node, then select the
sysadmin checkbox and finally click OK to complete the process as shown in
Figure C-6.
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4 Status

Conneclion

Server:
GE-TESTPC-1"SQLEXPRESS

Connection:
GE-TestPC-Twser

_‘!j Vigw connection properties

Progress
Ready

X Scipt « [ Help

Server role is used to grant server-wide security privileges to a user.

Serverroles:

[T] bulkadmin
[] dbereator

[] diskadmin
[”] processadmin
[¥] public

[] securityadmin

[] serveradmin

b

C

OK

DI aren |

Figure C-6: Sysadmin server role assigned

The SQL Server/ SQL Express login now has the required ‘sysadmin’ rights.
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C.2 General Faults

Table C-1 lists several problems and resolutions.

Table C-1: Problems & Resolutions

Problem

Resolution

Perception Server service
starts and then stops
within a few seconds.

This happens if the Perception Server service is started
without first using the license key to activate the
software. See Section 2.6 to activate the software.
Perception Server will fail to start if FILESTREAM is not
enabled for the Microsoft SQL Server instance.

If using Microsoft SQL Server 2012, this can happen if the
NT Authority\System account does not have ‘sysadmin’
privileges.

Users are no longer able to
log in even though
usernames and passwords
are correct

This can occur if a new server certificate has been
created on the Perception Server host. For example, if
Perception Server has been migrated to another
machine. To resolve, delete and recreate the users.

Perception Service does
not appear in Desktop
Discovery wizard.

This can be caused by several incorrect configurations.

= Ensure that the IP Address or Hostname of the
Perception Server is correct.

= For Perception version 1.18 or greater, ensure
that the UA Local Discovery Server service is
stopped. Verify in services.msc.

® Ensure that the Perception Server Service is
running. Verify in services.msc.

= Ensure that the SQL Service is running. Verify in
services.msc.

= Ensure that the Kelman database is configured in
the Perception Server Config Tool.

= Ensure MS-DTC is configured correctly:

= For Windows Server 2008, see
http://support.microsoft.com/kb/817064

® Ensure that the Perception Server and Discovery
Server certificates exist in the trusted certificate
folder and are configured correctly within the
services configuration files. To correct the
configuration, run the Perception Server installer
and select the repair option.

Database Upgrade Tool -
upgrade fails from KPD to
SQL Server when data
from one of the assets
already exists on the
Server

First export the data from a KPD database to a CSV file.
Use the Database Upgrade Tool to convert to the new
database. Import the data into the new database.

Perception Server
Configuration Tool tabs
not enabled

When using the Perception Server Configuration Tool
across multiple users on the same Microsoft Windows PC
the ‘Authenticated Users’ in Microsoft SQL must have
‘sysadmin’ profligates

Perception Server
installation fails error -
‘Console Error’.

Intermittent error - Perception Server installer fails to
complete and gives a ‘console error’, when installing on a
PC which has already had Perception Desktop or Server
installed previously.
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To resolve this issue:

1. Browse to C:\ProgramData\

2. Delete the 'OPC Foundation' folder

3. Browse to C:\Program Files (x86)\Common Files

(on x64 0OS)
4. Delete the 'OPC Foundation' folder

o

x86 OS)
6. Delete the 'OPC Foundation' folder
7. Uninstall Perception Desktop & Server
8. Re-install Perception Server

9. Re-install Perception Desktop

Browse to C:\Program Files\Common Files (on

Unable to restore Kelman
database in SQL Server

This occurs if FILESTREAM is not enabled for the
Microsoft SQL Server instance.
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Appendix D NERC-CIP Compliance

The following events are recorded in an audit log to assist organizations with
NERC-CIP compliance:

= Adding nodes.

= Deleting nodes.

» Add/delete references (drag-and-drop nodes).

= |mport events.

= Export events.

» Import export mapping changes (add, update and delete events).
= Server start stop events.

= Workflow configuration in transformer properties (adding, updating and
removing).

» Uploading workflow events on the server and deleting workflow events.
= Uploading wallboards.

» Save the wallboard configuration event, such as when moving a node
position on the wallboard.

= Write events for the configuration changes.

= Device setup event when launching setup.

= Login, logout events.

» Perception Server Configuration Tool changes.

Audit data is recorded in the following files:

= Audit-Server.log — contains audit data maintained by Perception Server.

= Audit-ServerConfiguration.log — contains audit data on the Perception
Server Configuration Tool.

The log files can be found at this location:

C:\ProgramData\GE Energy\Perception\Logs
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GE Grid Solutions (UK) Ltd

Lissue Industrial Estate East

Unit 1, 7 Lissue Walk, Lisburn, Co. Antrim
Northern Ireland, United Kingdom BT28 2LU
www.gegridsolutions.com/MD.htm

For further assistance or queries please contact:

Customer Service Centre (24 hours a day, 365 days a year)
T 1-877-605-5777, option 4 (United States and Canada)

T +44 1785-250-070 (Rest of the World)
ga.support@ge.com

Kelman is a trademark of GE Vernova. Other company or product names
mentioned in this document may be trademarks or registered trademarks
of their respective companies.

GE Vernova reserves the right to make changes to specifications of
products described at any time without notice and without obligation to
notify any person of such changes.

This material is accurate at the time of writing.

© 2024 GE Vernova and/or its affiliates. All rights reserved.

GE VERNOVA
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